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Creative WaveStudio is an easy-to-use yet powerful program that allows you
to record, play, and edit 8-bit (tape quality) and 16-bit (CD quality) audio
files in the Windows environment. You can use Creative WaveStudio to 
record from audio sources such as MIDI or an audio compact disc (CD); 
and although WaveStudio also offers you the choice of recording with 
line-in or a microphone, these two options are not supported by the PC
Compatibility Card.

IMPORTANT You must have Windows 95 or Windows version 3.1 or higher
installed on your system in order to use Creative WaveStudio.

This chapter provides you with information on using WaveStudio and its
powerful features. It is organized as follows:

m Starting Creative WaveStudio

m Understanding WaveStudio interface

m Using the mouse

m Understanding the WaveStudio menus

m Working with WaveStudio

m Customizing WaveStudio

m Using WaveStudio effectively 

m Using CD Sync

m Quitting WaveStudio
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Starting Creative WaveStudio

Creative WaveStudio has minor variations depending on the Windows version
installed on your computer. If you are using a version of Windows other than
Windows 95, refer to the onscreen help for WaveStudio when WaveStudio is
different from how it is described in this manual.

Starting Creative WaveStudio in Windows 95

1 Click the Windows 95 start button.

2 Point to Programs, then point to Sound Blaster 16 in the list of programs.

3 Click WaveStudio, located at the bottom of the Sound Blaster 16 list of programs.

A Creative WaveStudio window similar to Figure 1-1 appears.

Figure 1-1 The Creative WaveStudio window

Starting Creative WaveStudio in Windows version 3.1 or higher

1 Double-click the Audio Software program group in the Program Manager window.

2 Double-click the WaveStudio icon in the Audio Software program group window.

A Creative WaveStudio window similar to Figure 1-1 appears.
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Understanding the WaveStudio interface

The WaveStudio interface has four main features. They are the toolbar, edit
window, preview window, and status bar.

Toolbar

The toolbar includes buttons and control boxes for file and wave operations.
See Figure 1-2 for descriptions of what they do.

Figure 1-2 The toolbar

Button Description

New:  Opens a new window without any sound data.

Open:  Loads an existing sound file.

Save:  Saves the active sound file.

Cut:  Cuts the selected data of the active sound file.

Copy:  Copies the selected data of the active sound file.

Paste:  Pastes cut or copied data onto the active sound file.

Play:  Plays the sound file that is currently active in WaveStudio.

Stop:  Stops the playback of the active sound file.

cont inued .
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Button Description (continued)

Pause:  Pauses/Resumes the playback of the active sound file. 

Record:  Records a sound file.

Format:  Sets the default recording format.

Mixer:  Activates Creative Mixer.

CD:  Activates the CD player.

Box icon Description

Start box:  Displays the starting position of the sound data selection. You
can specify the position by typing a numerical value in the text box or use
the scroll arrows to select the starting position.

Size box:  Displays the size of the sound data selection. You can type the
size in the text box or use the scroll arrows to increase or decrease 
the size.

Zoom box:  Displays the zoom ratio of the sound file displayed. You can
type the ratio in the text box or use the scroll arrows to increase or
decrease the ratio. The smaller the value, the larger the magnification.
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Edit window

When you record a new sound file, or open an existing sound file, a smaller
edit window appears inside the Creative WaveStudio window and displays file
data (see Figure 1-3). You can open several files at a time in the edit window.
Choose Cascade from the Windows menu to stack the files behind each other.
Choose Tile Horizontally or Tile Vertically from the Windows menu to
display the files one on top of the other or side by side. Opening several files
at a time allows you to perform editing functions like copying data from one
file to another easily and quickly. For more information on the editing options
available in the edit window, refer to the edit menu table in “Understanding
WaveStudio Menus,” later in this chapter.

Only a small portion of sound file data can be viewed in the edit window. To
view all of the data in the file, use the horizontal and vertical scroll bars. The
horizontal scroll bar allows you to view the file data from beginning to end,
and the vertical scroll bar allows you to zoom into (or out of) the data.

Figure 1-3 Two sound files displayed in the edit window in Tile Vertically mode
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Preview window

The preview window condenses and displays in a single view all the data for
the sound file that is in the active edit window. The preview window and the
edit window are linked so that you can use the preview window to zoom in
on portions of data you want to edit. When you place your pointer in the
preview window, it changes to . You can then use the pointer in the
preview window to select the portion of the sound file you want to edit. The
portion of the file you select in the preview window is automatically loaded
into the edit window.

Located below the preview window is the progress indicator. The progress
indicator shows progress in playing back the sound file. If the entire file is
selected in the preview window, the progress indicator moves from the
beginning to the end of the file as it is played back. If only a portion of the
file is selected, the progress indicator moves only from the beginning to the
end of the selected portion.

Status bar

The status bar (see Figure 1-4) displays information about the sound file in
the active edit window. A window has to contain sound file data before any
information relevant to the file is displayed in the status bar. The status bar
also displays information about the menu options you select while working
with your sound file. When you select an option from the menu bar, the status
bar displays a brief description of the option you are pointing to with 
your pointer.

Figure 1-4 A status bar
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Using the mouse

Selecting the data you want to edit is easy when you use the mouse. The
following table explains how to select sound file data in the edit window
using the mouse. If you are using a multibutton mouse, use the left mouse
button for all mouse button operations in this table.

To select… Do this

a portion of the data Place the pointer at the beginning of the portion of data you
want, then drag to highlight the entire portion and release the
mouse button.

the entire data Double-click anywhere in the edit window.

data from a specific position Place the pointer at the chosen position, then drag to above 
back to the beginning of the data the edit window.

data from a specific position Place the pointer at the chosen position, then drag to below
to the end of the data the edit window.
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Understanding WaveStudio menus

WaveStudio has seven menus: File, Edit, View, Special, Options, Window, and
Help. It also has a context-sensitive menu that you can activate easily with
your mouse.

File menu

The File menu contains the following commands: 

Command Description

New Creates a new window without any data.

Open Loads an existing sound file.

Close Closes an open sound file.

Close All Closes all open sound files.

Save Saves changes made to the sound file.

Save As Saves the sound file with a new name.

Save All Saves all open sound files.

Exit Quits WaveStudio.

WaveStudio keeps a record of the last four sound files you have opened. The
recently opened files are displayed at the bottom of the File menu. To open
any of the files, click the file name.
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Edit menu

The Edit menu contains the following editing commands:

Command Description

Undo Restores the sound file to the state last saved.

Cut Copies and then removes the selected portion of the sound data.

Copy Copies the selected portion of the data.

Paste Pastes cut or copied sound data into the edit window. If you have selected
a portion of the data, that portion is replaced. Otherwise, WaveStudio
pastes the data at the pointer.

Paste Mix Mixes cut or copied sound data with the one in the edit window. When you
play the sound file, you will hear both sounds together.

Delete Deletes a selected portion of the data. Unlike the Cut command, the
Delete command doesn’t copy the data first.

Crop to Selection Deletes all the data except the portion selected.

Select All Selects the entire sound file in the edit window. You can also do this by
double-clicking anywhere within the edit window.

View menu

Use the commands in the View menu to customize the WaveStudio workspace:

Command Description

Preview Hides or displays the preview window. 

Toolbar Hides or displays the toolbar. 

Status Bar Hides or displays the status bar.

Fit Wave in Window Adjusts zoom ratio of the sound data display to fit the size of the edit window.

Actual Size Resets zoom ratio of the sound data display in the edit window to its actual
size (1:1).

Cursor Position Displays the sound file at the starting position of the highlighted sound
data selection.

Cursor End Displays the sound file at the ending position of the highlighted sound data
selection.

Zoom Zooms into the portion of the sound file selected.
(You should select the desired portion before using this function.)
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Special menu

Use the commands in the Special menu to add special effects to sound files:

Command Description

Reverse Reverses the playback of the entire or selected portion of the sound file.
For stereo files, there are options for reversing either channel.

Add Echo Adds echo effect to the entire or selected portion of the sound file. For
stereo files, there are options for adding echo to either channel.

Invert Waveform Inverts the sound data for the entire or selected portion of the sound file.
For stereo files, there are options for inverting either channel.

Rap! Repeats the selected portion of the sound file. 

Insert Silence Inserts silence into the selected portion of the sound file.

Force to Silence Silences the selected portion of the sound file. For stereo files, there are
options for silencing either channel.

Fade In Gradually increases the volume of the entire or selected portion of the
sound file. The starting magnitude of volume is determined by you and
increases to 100 percent. For stereo files, there are options for fading in
either channel or both channels.

Fade Out Gradually decreases the volume of the entire or selected portion of the
sound file. The volume decreases from 100 percent to whatever level you
choose. For stereo files, there are options for fading out either channel or
both channels.

Swap Channels Swaps the entire or selected portion of the sound file between the left and
right channels. For stereo files only.

Pan Left to Right Pans the entire or selected portion of the sound file from left to right. For
stereo files only.

Pan Right to Left Pans the entire or selected portion of the sound file from right to left. For
stereo files only.

Phase Shift Shifts one channel of the entire or selected portion of the sound file to the
right, causing a delay during playback. For stereo files only.

Convert Format Opens the Convert Format dialog box, which allows you to change the
channels, sampling rate, and sampling size of a sound file. For example, a
stereo file can be converted to a mono file by using the Convert Format
dialog box to change the channels, sampling rate, and sampling size to
mono levels.

Modify Frequency Modifies the frequency (playback rate) of the entire sound file.

Amplify Volume Changes the volume level of the entire or selected portion of the sound file.
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Options menu

Use the commands in the Options menu to change the WaveStudio default
settings: 

Command Description

Record Settings Sets the default record settings.

Mixer Settings Activates Creative Mixer.

Customize Colors Customizes WaveStudio display colors.

Display in Bytes Displays wave selection information in bytes.

Display in Samples Displays wave selection information in samples.

Display in Milliseconds Displays wave selection information in milliseconds.

Always on Top Makes WaveStudio the topmost window.

Window menu

Use the commands in the Window menu to organize the edit windows when
several sound files are open. For more information regarding these
commands, refer to your Microsoft Windows manual.

Help menu

Use the Help menu to find more information on Sound Blaster 16 programs
and features:

Command Description

Help Topics Searches for a topic in WaveStudio Help.

System Info Displays information about Windows and your system such as CPU and
available memory.

About WaveStudio Opens a window displaying copyright information.
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Context-sensitive menu

To see a menu of context-sensitive help in the edit window, press and release
the mouse button while holding down the x (Command) key. If you are using
a multibutton mouse, you can access the context-sensitive menu by clicking
the right mouse button. The commands that appear in the menu depend on
the content of the edit window. The commands include these possibilities:

Command Description

Play Plays the entire or selected portion of the sound file in the edit window.

Record Records the sound file. If the current active window in the edit window 
is an open file, the content in the open file will be replaced by the 
recorded file.

Stop Stops the playback of a sound file.

Mixer Settings Activates Creative Mixer.

Fit Wave in Window Adjusts the zoom ratio of the sound data display to fit the size of the edit
window.

Actual Size Resets the zoom ratio of the sound data display in the edit window to its
actual size (1:1).

Cursor Position Displays the sound file at the starting position of the highlighted sound
data selection.

Zoom Zooms into the selected portion of the sound file.

New Creates a new window without any data.

Open Loads an existing sound file.

Save Saves changes made to the sound file. 
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Working with WaveStudio

WaveStudio offers a variety of easy-to-use features to assist you in recording
and editing your sound files. This section shows you how to specify the
format for sound files, and how to open, save, and mix sound files.

Specifying sound wave formats

Before recording a sound file, you need to ensure that the format of the file is
specified correctly. Sound wave format refers to the sound channel and
sampling rate and size of the file. 

To specify the sound wave format:

1 Choose Record Settings from the Options menu.

The Record Settings dialog box similar to Figure 1-5 appears.

Figure 1-5 The Record Settings dialog box

2 Select the format for the sound file.

m Select Mono for one sound channel and Stereo for two sound channels.

m Select 11025 Hz for voice, 22050 Hz for cassette, and 44100 Hz for CD
quality recording.

m Select 8 bits for tape quality and 16 bits for CD sound quality.

3 Click OK.
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There is a trade-off between the quality of a sound file and the amount of
storage space required for the file. A sound file with better sound quality
requires more storage space because of its high sampling rate.

Opening sound files

To edit a sound file, you first need to open it. Sound files created or edited in
WaveStudio are in the WaveStudio format, and therefore have .WAV at the end
of their file names. If you open a file with raw data (.RAW) or Creative’s
Voice format (.VOC), a dialog box prompting you to confirm the conversion
of the file to .WAV format is displayed. 

To open a sound file:

1 Choose Open from the File menu.

The Open Sound File dialog box similar to Figure 1-6 appears.

Figure 1-6 The Open Sound File dialog box

2 Select the file you wish to open from the File Name list box. 

You may have to specify the directory where your file (.WAV) resides. To
listen to the playback of the sound file before opening it, click Play.

3 Click OK.
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Recording sound files

WaveStudio allows you to record new files or to record over existing files.

Recording a new sound file

To record a new sound file:

1 Click New on the toolbar, or choose New from the File menu.

2 Click Record on the toolbar. (If your toolbar is not visible, first choose Toolbar from the
View menu.)

The New Recording dialog box similar to Figure 1-7 appears.

Figure 1-7 The New Recording dialog box

3 Ensure the settings in the dialog box are specified correctly. 

m Check the recording level in the Recording Level group box. If the level is
too low or high, adjust it using the Mixer button.

m Check the path and file name created in the Record To File group box. You
can change the file name and directory by using the Browse button.

m Check the recording format shown at the bottom of the dialog box. You can
change the format by using the Settings button.

m Check your system’s storage space shown at the bottom of the dialog box. If
there is insufficient storage space for your file, free up more disk space or
select another drive before recording the file.
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4 Click Start. 

IMPORTANT You can click the CD Player button to launch the CD player. Also,
you can select the CD Sync checkbox to synchronize the start of the recording
with the playback of your audio CD.

Recording over an existing sound file

To record over an existing sound file:

1 Activate the file you want to record over.

2 Click Record on the toolbar. (If your toolbar is not visible, first choose Toolbar from the
View menu.)

The Record Over dialog box similar to Figure 1-8 appears.

Figure 1-8 The Record Over dialog box

3 Click Start.

Saving new sound files

To save a sound file you have just recorded:

1 Click Save on the toolbar or choose Save from the File menu. 

2 Enter the name of the file and the path if prompted.

3 Click OK.
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Assigning a new name or format to an existing sound file

If you want to use the data in an existing sound file as the basis for another
sound file, you can save the existing sound file under a new name or format
and then edit the sound data in the new file.

To give an existing sound file a new name or format:

1 Choose Save As from the File menu.

The Save Sound File dialog box similar to Figure 1-9 appears.

Figure 1-9 The Save Sound File dialog box

2 Enter a new name for the file and the path if prompted. 

3 Select the desired file format and compression method from the “Save File as Type” and
“Compression/Conversion” drop-down list boxes respectively.

4 Click OK.

IMPORTANT Compression is not available for 8-bit sound files. Also, you can
convert a Windows sound file to a different format by selecting PCM
Conversion from the Compression/Conversion drop-down list box.
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Mixing data from multiple sound files

When you mix the data of two sound files, you are actually adding the data of
one file to another to create a new file. After mixing, you can play back the
new file to hear the new sound generated.

To mix the data contents of two sound files:

1 Activate the first (source) file and select the desired portion of the data for mixing.

2 Choose Copy from the Edit menu.

The data copied is stored in an internal buffer. 

3 Activate the second (target) file and select the location where you want the copied data
to be mixed.

4 Choose Paste Mix from the Edit menu.

A Paste Mix dialog box similar to Figure 1-10 appears.

Figure 1-10 The Paste Mix dialog box

5 Select the desired channels for copying data from the source file in the From Buffer Use
group box and for mixing data with the target file in the Mix With Wave group box. 

m Select Left Channel, Right Channel, or Both Channels for stereo file.

m Select Mono Channel for a mono file.
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6 Click OK.

If a portion of the target file is not selected, the data is mixed where the
pointer is. If a portion of the target file is selected, the copied data in the
buffer is mixed with the portion selected.

IMPORTANT You cannot mix 8-bit with 16-bit sound data. However, you can
convert both files to either 16-bit or 8-bit sampling size before mixing them.

Adding special effects

WaveStudio allows you to enhance your sound files with special effects from
the Special menu. These effects include Reverse, Add Echo, Invert Waveform,
Rap!, Insert Silence, Force to Silence, Fade In and Fade Out, Swap Channels,
Pan Left to Right and Pan Right to Left, Phase Shift, Convert Format, Modify
Frequency, and Amplify Volume. 

Reverse

This effect reverses the sequence of the data in the sound file so that the
sound is played backwards. You can specify a selected portion of the file to be
reversed. If no portion of the file is selected, the entire file will be reversed. 

To reverse a file:

1 Choose Reverse from the Special menu.

A Reverse dialog box similar to Figure 1-11 appears.

Figure 1-11 The Reverse dialog box

2 If you are editing a stereo file, select Left Channel, Right Channel, or Both Channels. 
If you are editing a mono file, Mono Channel is already selected.

3 Click OK.
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Add Echo

Add Echo modifies data in the sound file to give it an echo effect. You can
create a metallic sound effect by continually applying Add Echo to the same
sound file until you have achieved the desired result. To add echo to a file:

1 Choose Add Echo from the Special menu. 

The Add Echo dialog box similar to Figure 1-12 appears.

Figure 1-12 The Add Echo dialog box

2 Enter the echo magnitude (loudness of the echo) in the Magnitude text box. The
maximum magnitude you can enter is 200 percent.

3 Enter the echo delay (the time between the actual sound and the echo) in the Echo Delay
text box.

4 If you are editing a stereo file, select Left Channel, Right Channel, or Both Channels. 
If you are editing a mono file, the options for channels are not available.

5 Click OK.
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Invert Waveform

The Invert Waveform effect inverts the sound file along its horizontal axis.
You can specify a selected portion of the file to be inverted. If a specific
portion of the file is not selected, the entire file will be inverted. To create an
unusual effect, invert only one channel of a stereo file. 

To invert a file:

1 Choose Invert Waveform from the Special menu.

An Invert Waveform dialog box similar to Figure 1-13 appears.

Figure 1-13 The Invert Waveform dialog box

2 If you are editing a stereo file, select Left Channel, Right Channel, or Both Channels. 
If you are editing a mono file, Mono Channel is already selected.

3 Click OK.

Rap!

This feature repeats the selected portion of the sound file. This is useful when
you want to create a jerky or stuttering effect for your voice files. To repeat 
a selection:

1 Select a portion of the file. 

2 Choose Rap! from the Special menu.
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Insert Silence

This effect inserts silence into a selected portion of the sound file. 

To insert silence into a file:

1 Select a portion of the sound file. 

The length of the silence depends on the length of the portion selected.

2 Choose Insert Silence from the Special menu.

You will see a straight line representing the silence inserted into the portion
selected.

Force to Silence

This effect mutes the selected portion of the sound file so that the selected
portion will not be heard during playback. 

To mute a file:

1 Select a portion of the file.

2 Choose “Force to Silence” from the Special menu.

The Force to Silence dialog box similar to Figure 1-14 appears.

Figure 1-14 The Force to Silence dialog box

3 If you are editing a stereo file, select Left Channel, Right Channel, or Both Channels. 
If you are editing a mono file, Mono Channel is already selected.

4 Click OK.

The selected portion is replaced by a straight line.
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Fade In and Fade Out

You can create a fading in (soft to loud) or fading out (loud to soft) effect for
your sound files. Use the instructions below for Fade In to help you use Fade
Out. The Fade In and Fade Out dialog boxes are very similar.

To use Fade In:

1 Choose Fade In from the Special menu.

A Fade In dialog box similar to Figure 1-15 appears.

Figure 1-15 The Fade In dialog box

2 Enter the starting magnitude in the Magnitude text box. 

3 If you are editing a stereo file, select Left Channel, Right Channel, or Both Channels. 
If you are editing a mono file, the options for channels are not available.

4 Click OK.

IMPORTANT For Fade In, the file will be linearly faded in from the starting
magnitude (volume) to 100 percent. For Fade Out, the file will be linearly
faded out from a 100 percent magnitude to the ending magnitude.

Swap Channels

This effect swaps the entire or selected portion of wave data between the left
and right channels. This effect is only applicable to stereo sound files. 

To swap the channels of a wave:

Choose Swap Channels from the Special menu.
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Pan Left to Right and Pan Right to Left

The “Pan Left to Right” effect pans the data of sound files from the left to the
right channel. The “Pan Right to Left” effect pans the data from the right to
the left channel. This feature is useful if you want to simulate the movement
of a sound source from one end of a sound stage to the other. 

To use “Pan Left to Right” (or vice versa):

Choose “Pan Left to Right” from the Special Menu.

Phase Shift

This effect allows you to delay the playback of the selected channel. This
effect is only applicable to stereo sound files. However, you can convert a
mono sound file to a stereo sound file by applying this effect. This gives the
converted mono file a pseudo-stereo effect.

To create a phase shift effect:

1 Choose Phase Shift from the Special menu.

The Phase Shift dialog box similar to Figure 1-16 appears.

Figure 1-16 The Phase Shift dialog box

2 Select the desired measurement unit from the Delay Resolution group box.

3 Enter the number of units of delay you want in the Phase Delay text box.

4 Select Left Channel or Right Channel from the Apply Phase Shift To group box.

5 Click OK.
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Convert Format

Convert Format allows you to convert between mono and stereo files, 8-bit
and 16-bit files, and different frequencies. 

To convert the format of a file:

1 Choose Convert Format from the Special menu.

The Convert Format dialog box similar to Figure 1-17 appears.

Figure 1-17 The Convert Format dialog box

2 Select the desired channel from the Channels group box.

3 Select the desired sampling rate and size from the Sampling Rate and Sampling Size
group boxes respectively.

4 Click OK.

IMPORTANT Conversion is a complex process and may take a long time to
complete, depending on the size of the file.
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Modify Frequency

You can modify the frequency (playback rate) of sound files by selecting from
three fixed frequencies: 11025 Hz, 22050 Hz, or 44100 Hz. Selecting a higher
frequency causes a faster playback while a lower frequency causes a slower
playback. This effect is applied to the entire file. 

To modify the frequency of a file:

1 Choose Modify Frequency from the Special menu.

The Modify Frequency dialog box similar to Figure 1-18 appears.

Figure 1-18 The Modify Frequency dialog box

2 Select the desired frequency.

3 Click OK.

IMPORTANT If your file is already at the maximum frequency of 44100 Hz, use
Convert Format from the Special menu to convert it to 22050 Hz first before
using this effect.
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Amplify Volume

This effect allows you to change the volume of sound files. It can be applied
to the entire or selected portion of the sound file. 

To change the volume of a file:

1 Choose Amplify Volume from the Special menu.

The Amplify Volume dialog box similar to Figure 1-19 appears.

Figure 1-19 The Amplify Volume dialog box

2 Enter the magnitude in the Magnitude text box. The maximum magnitude you can enter
is 500 percent.

3 If you are editing a stereo file, select Left Channel, Right Channel, or Both Channels. 
If you are editing a mono file, the options for channels are not available.

4 Click OK.
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Customizing WaveStudio

WaveStudio allows you to customize the default settings for recording,
Creative Mixer, and the display color of the WaveStudio interface. 

Recording

When you customize the record settings, future recordings of sound files will
be based on those settings.

To customize the record settings:

1 Choose Record Settings from the Options menu.

The Record Settings dialog box similar to Figure 1-5 appears. 

2 Specify the desired settings.

3 Click OK.

Creative Mixer

To adjust the settings for Creative Mixer:

1 Click Mixer on the toolbar, or choose Mixer Settings from the Options menu.

Creative Mixer appears.

2 Specify the desired settings.

Note:  For more information on using the Creative Mixer, refer to Chapter 4,
“Creative Mixer.”
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Display color

You can customize the colors used to display sound data in both the edit and
preview windows, or you can reset the customized colors back to the default
color scheme.

Customizing the color

To customize the display color:

1 Choose Customize Colors from the Options menu.

The Customize Colors dialog box similar to Figure 1-20 appears.

Figure 1-20 The Customize Colors dialog box

2 Select the display elements you want to customize in the Edit Window Display Colors
and Preview Window Display Colors group boxes.

A color selection box appears. 

3 Click the color you want.

4 Click OK.
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Restoring the original color

To restore the display elements to their original color scheme:

Click Defaults. 

Using WaveStudio effectively

To use WaveStudio effectively, you need to know the amount of memory
needed to run WaveStudio, how to manage your files, and how to work with
compressed files.

Memory requirements

WaveStudio requires about one megabyte (MB) of memory. Additional
memory is needed for the buffers when you play back or record sound files.

When you open a file for editing, WaveStudio will only allocate a certain
amount of memory for storing the necessary information and will not load
the entire file into memory. The file will be edited directly from your hard
disk. As such, you can edit files as large as your hard disk can contain.

File management

This section explains how you can optimize your system for speed and
manage your sound files effectively.

System optimizing

When you record sound files, WaveStudio will store recorded data directly 
to the hard disk. High resolution recording of data, particularly 16-bit data 
at 44100 Hz, will take longer to write to your disk if it is not optimized 
for speed. 

You can reduce the amount of time your system spends reading and 
writing data by compacting your hard disk using a disk-compaction utility
such as Disk Defragmenter and installing a disk cache utility such as
SMARTDRV.EXE. For more information on using these utilities, consult 
your Windows 95 documentation.
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Number of open files

WaveStudio does not limit the number of files you can open. But the number
of files WaveStudio can open at a time depends on how you specify your
operating system configuration. For more information on how to do that,
consult your operating environment documentation.

Use of DOS SHARE utility

It is recommended that you use the DOS SHARE utility to allow proper file
sharing and locking. This will prevent you from accidentally deleting a file
while WaveStudio is accessing it. For more information on how to use this
utility, consult your DOS documentation.

Compressed sound files

To work effectively with compressed sound files, you need to know how
compressed files are opened and edited.

Opening compressed files

WaveStudio currently supports five compression formats: Microsoft ADPCM,
CCITT A-Law, CCITT µ-Law, IMA/DVI ADPCM, and Creative ADPCM. 

When you open a compressed sound file, WaveStudio will decompress the
file first before displaying it. You must ensure that the file resides on a drive
that has sufficient disk space to accommodate the uncompressed data.

The amount of space required depends on the compression format adopted.
For CCITT A-Law and µ-Law, the compression ratio is 1:2
(compressed:uncompressed). For ADPCM, the ratio is 1:4. For example, if
you are working with a 1 MB ADPCM file, you need to have at least 4 MB of
free disk space.

Editing compressed files

When you open a compressed sound file for editing, WaveStudio will
automatically compress the file when you save it. As this can be time-
consuming for large files, you should save your work as an uncompressed
wave (PCM) file first. Once you have finished editing, save the file with the
desired compression format.
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Using CD Sync

CD Sync allows you to synchronize the start of the recording with the
playback of audio CDs.

If you have mistakenly placed a CD-ROM data disc instead of an audio CD 
in your CD-ROM drive, the program will inform you of the error; but the
recording will still continue. To stop the recording, click Stop on the toolbar.
Insert the correct audio CD and then click Record on the toolbar to record
over your file. If you do not want the CD Sync option, uncheck it before
proceeding with the recording.

Quitting WaveStudio

To quit WaveStudio:

Choose Exit from the File menu.

If changes to the file have not been saved, a dialog box will prompt you to
save the changes.
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Creative Remote resembles the remote control of a home stereo system.
Creative Remote works in conjunction with three different audio players:
Creative CD, Creative Wave, and Creative MIDI. Creative CD plays audio 
CDs from your CD-ROM drive, Creative Wave plays sound files created in
WaveStudio, and Creative MIDI plays MIDI files. You can use Creative
Remote to play audio in standard ways through the different players. If you
wish to have still more control over each kind of audio, you can use Creative
Remote to open and use the individual Creative CD, Creative Wave, and
Creative MIDI players.

IMPORTANT You must have Windows 95 or Windows version 3.1 or higher
installed on your system in order to use Creative Remote.

In addition to controlling the audio output for the three players, you can use
Creative Remote in conjunction with Creative Wave to record audio from a
CD or a MIDI file and to save it as a sound file. Although Creative Wave also
offers the option of recording using line input or microphone input, the 
PC Compatibility Card does not support these options.

This chapter is organized as follows:

m Using Creative Remote

m Using Creative CD

m Using Creative Wave

m Using Creative MIDI

2 Creative Remote and the Creative CD, 
Wave, and MIDI Players



Using Creative Remote

You can use Creative Remote to play audio through Creative CD, Creative Wave,
and Creative MIDI all at the same time. However, Creative Remote can only
make adjustments to one player at a time. This player is called the active player.

Starting Creative Remote

Creative Remote varies slightly depending on the version of Windows
installed on your computer. If you are using a version of Windows other than
Windows 95, refer to the onscreen help when Creative Remote is different
from how it is described in this manual.

Starting Creative Remote in Windows 95

1 Click the Windows 95 start button.

2 Point to Programs, then point to Sound Blaster 16 in the list of programs.

3 Click Creative Remote in the Sound Blaster 16 list of programs.

The Creative Remote controls similar to those in Figure 2-1, appear.

Figure 2-1 Creative Remote
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Starting Creative Remote in Windows version 3.1 or higher

1 Double-click the Audio Software program group in the Program Manager window.

2 Double-click the Creative Remote icon in the Audio Software program group window.

The Creative Remote controls similar to those in Figure 2-1, appear.

Creative Remote features
Creative Remote consists of the following features:

m “touch sensitive” display

m power off button

m menu button

m minimize button

m active player selector/display

m invoke player button

m playlist button

m playback control buttons

m volume control buttons

m fast track selector

The “touch sensitive”/display in Creative Remote

By clicking the “touch sensitive” display, you can switch among the following:

Power off button

Click the power off button to quit Creative Remote.

Current system time

Title of the current playlist

Title of the current track

Name of the current artist



Menu button

Click the menu button to display the Control menu, shown below in 
Figure 2-2:

Figure 2-2 The Creative Remote Control menu

Minimize button

The minimize button changes the Creative Remote control panel to an icon at
the bottom of your screen. To maximize Creative Remote, returning it to its
original size, double-click the Creative Remote icon.

Active player selector/display

The active player selector displays the icon of the active player once you select
it. The icons of the players are the following:
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Invoke player button

Click the invoke player button to open Creative CD, Creative MIDI, or
Creative Wave.

Playlist button

The playlist button opens the Playlist dialog box, where you can rearrange
your tracks/sound files into a customized playing order. 

Playback control buttons

The playback control buttons allow you to perform the playback operations on
the active player. 

Button Description

Stops the track/sound file.

Plays the track/sound file.

Pauses the track/sound file.

Records sound from a selected source within Creative Wave.

Plays the previous track/sound file.

Rewinds the track/sound file.

Fast forwards the track/sound file.

Plays the next track/sound file.

Loads or unloads the CD within Creative CD.

Volume control buttons

The volume control buttons decrease and increase the volume 
(see Figure 2-3).

Figure 2-3 Creative Remote volume control buttons
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Fast track selector

The fast track selector is an array of buttons that allow you to select a
particular track or sound file in the playlist (see Figure 2-4). For example, to
play the second track or sound file, click button 2. If you have more than ten
tracks or sound files in your playlist, click the two buttons that make up the
number. For example, to play the twelfth track or sound file, click button 1
and then button 2.

Figure 2-4 Creative Remote fast track selector

Activating a player

Before you can control a player with Creative Remote, you need to activate 
a player.

To activate a player:

1 Click the active player selector/display.

The player selection buttons appear.

2 Click the button of the player you want to activate.

The player becomes active and the icon of the active player appears on the
active player selector/display.
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Playing tracks or sound files

You can play tracks or sound files using the playback control buttons. Creative
Remote plays tracks or sound files from the active player’s playlist. You can
also select a track or sound file and play it using the fast track selector. 

To play a track or sound file using the fast track selector:

Click the button in the fast track selector that corresponds to the track or
sound file you want to play. If you want to play track 10, click 0. If you want to
play track 12, click 1 and then click 2.

IMPORTANT If you choose a track or sound file number that does not exist, the
last track or sound file in the playlist will be selected.

Compiling a playlist

You can compile a playlist by clicking the playlist button. When you click this
button, a Playlist dialog box appears allowing you to perform operations such
as adding, deleting, and rearranging tracks or sound files.

Note: For more information on how to compile the playlist, refer to the
relevant section about the active player later in this chapter.

Opening a player

You can open a specific player to control more aspects of that type of audio
than are possible in Creative Remote. For example, you can switch to 
Creative CD to play tracks in random order and preview the first few seconds
of each track in the playlist. When you open a player, you make it active in
Creative Remote.

To open a player:

1 Click the invoke player button.

The player selection buttons appear.
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2 Click the button of the player you want to open.

Alternatively, if you want to open the active player, double-click the active
player selector/display.

Using the hot keys

You can use hot keys (key commands) to perform operations on Creative
Remote. The following are some of the hot keys available:

Key command Description

<A> Pauses the track/sound file.

<B> Plays the previous track/sound file.

<C> Activates the active player selector/display.

<Ctrl+D> Changes the information displayed on the “touch sensitive” display.

<D> Decreases the volume.

<E> Loads/ejects the CD.

<F> Plays the next track/sound file.

<F1> Activates the onscreen help.

<H> Activates the invoke player button.

<K> Rewinds the track/sound file.

<L> Opens the playlist.

<N> Minimizes Creative Remote to an icon.

<O> Quits Creative Remote.

<P> Plays the track/sound file.

<R> Records the sound file.

<S> Stops the track/sound file.

<Space bar> Confirms selection.

<U> Increases the volume.

<W> Fast forwards the track/sound file.

<0> to <9> Selects the track/sound file.
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Using Creative CD

You can use Creative CD to perform operations such as playing audio CDs,
compiling the playlist, and giving names to the tracks on your CD.

Starting Creative CD

Creative CD has minor variations depending on the Windows version
installed on your computer. If you are using a version of Windows other than
Windows 95, refer to the onscreen help when Creative CD is different from
how it is described in this manual. In addition to starting Creative CD as
described here, you can also start it from Creative Remote with the invoke
player button.

Starting Creative CD in Windows 95

1 Click the Windows 95 start button.

2 Point to Programs, then point to Sound Blaster 16 in the list of programs.

3 Click Creative CD in the Sound Blaster 16 list of programs.

The Creative CD controls similar to those in Figure 2-5, appear.

Figure 2-5 Creative CD

Starting Creative CD in Windows version 3.1 or higher

1 Double-click the Audio Software program group in the Program Manager window.

2 Double-click the Creative CD icon in the Audio Software program group window.

The Creative CD controls similar to those in Figure 2-5, appear.
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Creative CD features

Creative CD consists of the following features:

m “touch sensitive” display

m power off button

m menu button

m minimize button

m playlist button

m playback control buttons

m fast track selector

The “touch sensitive” display in Creative CD

By clicking the “touch sensitive” display, you can switch among displays of
these categories of information:

m CD-ROM drive status (indicates whether a CD is in the CD-ROM drive)

m CD and track title

m artist name and track title

m track number and duration

A “touch sensitive” display for track number and duration is shown in 
Figure 2-6.

Figure 2-6 The “touch sensitive” display for track number and duration
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The “touch sensitive” display contains the following components:

Item Description

Player selector Allows you to control up to four CD-ROM drives—CD 1, CD 2, CD 3, and
CD 4. Select CD 1 to connect to your Macintosh CD-ROM drive. The PC
Compatibility Card only supports CD 1, the Macintosh CD-ROM drive.

Graphic slider Indicates the percentage of the current track that has been played; allows
you to control the position of the playing track.

Graphic volume Shows the volume level of the player. 
control

Two-digit mode Allows you to select a track number above ten in the playlist.
selector

Repeat mode selector Repeats the whole playlist when the final track has played.

Introduction mode Plays the first few seconds of the tracks in the playlist.
selector

Shuffle mode selector Randomly changes the order of the playlist.

Power off button

Click the power off button to quit Creative CD.

Menu button

The menu button displays the Control menu, shown below in Figure 2-7:

Figure 2-7 The Creative CD Control menu
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Minimize button

The minimize button changes the Creative CD control panel to an icon at the
bottom of your screen. To maximize Creative CD, returning it to its original
size, double-click the Creative CD icon.

Playlist button

The playlist button allows you to compile a selection of the tracks that you
want to play. When you click the playlist button, a CD Playlist dialog box
similar to Figure 2-8 appears.

Figure 2-8 The CD Playlist dialog box
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The CD Playlist dialog box contains the following components:

Item Description

CD Artist/Title Allows you to name your CD.

Track title Allows you to name the tracks on your CD.

Play Displays the tracks that are in the playlist.

Track List Displays the tracks on your CD.

Play Plays the selected tracks in the Playlist or Track List list box.

Add Adds the selected tracks in the Track List list box to the Playlist list box. 

Add All Adds all the tracks in the Track List to the Playlist list box.

Clear Clears the tracks in the Playlist list box.

Remove Removes the selected tracks from the Playlist list box.

Done Confirms the compilation of the tracks in the Playlist list box.

Cancel Cancels changes made to the track in the Playlist list box. The playlist
reverts to its last saved copy.

Help Displays the onscreen help facility.

Playback control buttons

The playback control buttons allow you to perform playback operations on
Creative CD. 

Button Description

Stops the track.

Plays the track.

Pauses the track.

Plays the previous track.

Quickly rewinds the track.

Quickly forwards the track.

Plays the next track.

Loads or unloads the CD.
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Fast track selector

The fast track selector allows you to select a track that you want to play 
(see Figure 2-9).

Figure 2-9 The Creative CD fast track selector

Playing tracks

You can play the tracks using the playback control buttons and fast 
track selector. 

To play a track using the fast track selector:

Click the button from the fast track selector that corresponds to the track you want to
play. If you want to play track 10, click 0. If you want to play track 12, click 1 and then
click 2.

IMPORTANT If you choose a track number that does not exist, the last track in
the playlist will be selected. 

If you want to play a track from a certain point, you can use the graphic slider
to change the track’s playing position. You can change this before playing the
track or while the track is playing.

To play a track starting at a different point:

1 Press and hold down the mouse button on the graphic slider and go to the point at which
you want to start the track, then release the mouse button.

If your player is already playing, the player will immediately go to the point
you have chosen and start playing.

2 If your player is not playing, click the play button to start playing the track from the point
you have chosen.
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Adjusting the volume

You can adjust the volume of Creative CD using the graphic volume control. 

To adjust the volume:

1 Press and hold down the mouse button on the graphic volume control.

2 Adjust the volume to the level you want.

Working with the CD playlist

A playlist is a collection of tracks that are grouped in some order for playing.
You can compile the tracks in the playlist using the CD Playlist list box.

Compiling the playlist

To compile the playlist:

1 Click the Playlist button.

The CD Playlist dialog box appears (see Figure 2-8).

2 Perform the desired operations on the playlist:

m preview tracks 

m add tracks

m remove tracks 

m rearrange tracks 

m name the tracks and playlist 

3 Click Done when you are satisfied with the compilation of the playlist. 

Adding tracks to the playlist

To add tracks to the playlist:

1 Select the tracks to add to the playlist from the Track List list box.

2 Click Add to add the tracks to the Playlist list box.

Note:  To add all the tracks in the Track List list box to the Playlist list box,
click Add All.
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Previewing tracks

To preview tracks:

1 Select the tracks from the Playlist or Track List list box.

2 Click Play.

The first track starts playing.

Note: You can also preview a track by double-clicking the track in a list box.

Removing tracks from the playlist

To remove tracks from the playlist:

1 Select the tracks you want to remove from the Playlist list box.

2 Click Remove.

Note:  To remove all the tracks from the Playlist list box at once, click 
Remove All.

Selecting tracks in the playlist

You can select multiple tracks for previewing, adding, or removing by holding
down <Ctrl> or <Shift> while you choose them.

m Pressing <Ctrl> allows you to randomly select the tracks. 

m Pressing <Shift> allows you to select a group of adjacent tracks when you select the
first and last tracks in the group.

Rearranging tracks in the playlist

You can use your mouse to rearrange the tracks in the playlist.

To move a track in the playlist using a single-button mouse:

Hold down the x (Command) key as you drag the track in the Playlist list box to the new
position.

To move a track in the playlist using a multibutton mouse:

Use the right mouse button to drag the track in the Playlist list box to the new position.

The track moves to the position you choose.
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IMPORTANT If you are in shuffle mode, Creative CD will continue to play the
tracks randomly. To leave shuffle mode, click the shuffle mode button on the
“touch sensitive” display to deselect it. Once you have left shuffle mode,
Creative CD will use your rearranged playlist.

Naming the playlist

Once you have compiled your playlist, you may want to give the playlist 
a title. To give your playlist a title:

1 Highlight the CD Artist/Title edit box.

2 Type the title in the edit box.

Naming the tracks

To name a track on your CD:

1 Select the track in the Track List list box.

The track appears in the Track Title edit box.

2 Highlight the track.

3 Type the new name and press <Return>.

The name of the track is changed. 

49Creat ive Remote



Using the hot keys

You can use hot keys (key commands) to perform operations on Creative CD.
These hot keys are as follows:

Key command Description

<A> Pauses the track.

<B> Plays the previous track.

<Ctrl+D> Changes the information shown on the “touch sensitive” display.

<E> Loads/ejects CD.

<F> Plays the next track.

<F1> Activates onscreen help.

<G> Activates the graphic slider.

<H> Activates shuffle mode selector.

<I> Activates introduction mode selector.

<K> Rewinds the track.

<L> Opens the playlist.

<M> Activates repeat mode selector.

<N> Minimizes Creative CD to an icon.

<O> Quits Creative CD.

<P> Plays the track.

<S> Stops the track.

<Space bar> Confirms selection.

<W> Fast forwards the track.

<0> to <9> Selects tracks.
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Using Creative Wave

You can use Creative Wave to perform operations such as playing a sound file
created in WaveStudio, compiling a playlist, and recording a MIDI file or
audio CD. Recording with line or microphone input is not supported by the
PC Compatibility Card. 

Starting Creative Wave

Creative Wave has minor variations depending on the Windows version
installed on your computer. If you are using a version of Windows other than
Windows 95, refer to the onscreen help when Creative Wave is different from
how it is described in this manual. In addition to starting Creative Wave as
described here, you can also start it from Creative Remote with the invoke
player button. 

Starting Creative Wave in Windows 95

1 Click the Windows 95 start button.

2 Point to Programs, then point to Sound Blaster 16 in the list of programs.

3 Click Creative Wave in the Sound Blaster 16 list of programs.

The Creative Wave controls similar to those in Figure 2-10, appear.

Figure 2-10 Creative Wave

Starting Creative Wave in Windows version 3.1 or higher

1 Double-click the Audio Software program group in the Program Manager window.

2 Double-click the Creative Wave icon in the Audio Software program group window.

The Creative Wave controls similar to those in Figure 2-10, appear.
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Creative Wave features

The Creative Wave interface consists of the following features:

m “touch sensitive” display

m power off button

m menu button

m minimize button

m playlist button

m playback control buttons

m record setting button

m fast track selector

The “touch sensitive” display in Creative Wave

By clicking the Creative Wave “touch sensitive” display, you can switch among
displays of these categories of information:

m sound file playing status (showing whether a selected sound file is
currently playing)

m titles of the sound file and playlist 

m the number and elapsed time of the playing sound file 

A “touch sensitive” display for the number and elapsed time of the playing
sound file is shown in Figure 2-11.

Figure 2-11 The “touch sensitive” display for the number and elapsed time of the
playing sound file

Track/sound file info

Shuffle mode selector

Introduction mode selector

Graphic volume control

Graphic slider

Repeat mode selector



53Creat ive Remote

The “touch sensitive” display contains the following components:

Item Description

Graphic slider Indicates the percentage of the current sound file that has played. It also
allows you to play the sound file from a different point in the file.

Graphic volume Shows the volume level of the player. 
control

Repeat mode selector Repeats the whole playlist when the final sound file has played.

Introduction mode Plays the first few seconds of all sound files in the playlist.
selector

Shuffle mode selector Randomly plays the sound files in the playlist.

Power off button

Click the power off button to quit Creative Wave.

Menu button

Click the menu button to display the Control menu (Figure 2-12).

Figure 2-12 The Creative Wave Control menu
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Minimize button

The minimize button changes Creative Wave to an icon at the bottom of your
screen. To maximize Creative Wave, returning it to its original size, double-
click the Creative Wave icon.

Playlist button

The playlist button allows you to compile the desired sound files for playing.
When you click this button, the Wave Playlist dialog box similar to 
Figure 2-13 appears.

Figure 2-13 The Wave Playlist dialog box
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The Wave Playlist dialog box contains the following components:

Item Description

Collection Edit Box Allows you to give a title to your playlist.

New Collection Allows you to create a new collection title.

Save Saves the playlist using the name provided in the Collection edit box.

Save As Saves the playlist with a new name.

Delete Deletes the playlist in the Collection edit box.

Play Plays the selected sound files.

Stop Stops the selected sound file from playing.

Forward Forwards you to the next sound file in the playlist.

Playlist Displays the files you have included in the playlist.

Add Adds selected sound files to the Playlist list box. 

Add All Adds all the sound files to the Playlist list box.

Remove Removes selected sound files from the Playlist list box.

Remove All Removes all the sound files in the Playlist list box. 

Directory Displays the directory search path.

File-List List Box Lists available sound files that can be added to the playlist.

File Name and Location Tells you the name and directory location of the selected sound file.

Sound File Artist Displays the artist name, if any, of the selected sound file. (Applies to 
CD tracks; wave files do not have an artist attached to them.)

Memo Pad Allows you to type a brief description or memo about the selected 
sound file.

Done Confirms the compilation of sound files in the Playlist list box.

Cancel Cancels changes made in the Playlist list box. The playlist reverts to its 
last saved copy.

Help Displays the onscreen help facility.
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Playback control buttons

The playback control buttons allow you to perform the playback operations. 

Button Description

Stops the sound file.

Plays the sound file.

Pauses the sound file.

Records a sound file from a selected source.

Plays the previous sound file in the playlist.

Quickly rewinds the sound file.

Quickly forwards the sound file.

Plays the next sound file in the playlist.

Record setting button

The record setting button displays a dialog box that allows you to define the
settings for recording.

Fast track selector

The fast track selector allows you to select and play a sound file in the playlist
(see Figure 2-14).

Figure 2-14 The Creative Wave’s fast track selector

Playing sound files

You can play sound files by using the playback control buttons and fast 
track selector.

56 Chapter  2



To play a sound file using the fast track selector:

Click the button from the fast track selector that corresponds to the sound file you want to
play. If you want to play file 10, click 0. If you want to play file 12, click 1 and then click 2.

IMPORTANT If you choose a sound file number that does not exist, the last
sound file in the playlist will be selected.

If you want to play a sound file from a certain point, you can use the graphic
slider to indicate where to start. You can do this before playing the file or
while it is playing.

To play the sound file starting at a different point:

1 Press and hold down the mouse button on the graphic slider and go to the point at which
you want to start the sound file, then release the mouse button.

If your player is already playing, the player will immediately go to the point
you have chosen and start playing.

2 If your player is not playing, click Play to start playing the sound file from the point you
have chosen.

Adjusting the volume

You can adjust the volume of Creative Wave using the graphic volume control.

To adjust the volume:

1 Press and hold down the mouse button on the graphic volume control.

2 Adjust the volume to the level you want.
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Working with the wave playlist

A playlist is a collection of tracks that are grouped in some order for playing.
You can compile the tracks in the playlist using the Wave Playlist list box.

Compiling the playlist

To compile the playlist:

1 Click the playlist button.

The Wave Playlist dialog box similar to Figure 2-13 appears.

2 Perform the desired operations on the playlist:

m preview sound files

m add sound files

m remove sound files 

m rearrange or name sound files 

3 Click Done when you are satisfied with the compilation of the playlist.

Adding sound files to the playlist

To add sound files to the playlist:

1 Select the sound files to add to the playlist from the Files list box.

2 Click Add to add the sound files to the Playlist list box.

Note:  To add all the sound files in the Files list box to the Playlist list box,
click Add All.

Previewing sound files

To preview sound files:

1 Select the sound files from the Playlist or Files list box.

2 Click Play.

The sound file starts playing.

Note: You can also preview a sound file by double-clicking the sound file in a
list box.
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Removing sound files from the playlist

To remove sound files from the playlist:

1 Select the sound files from the Playlist list box.

2 Click Remove.

Note:  To remove all the sound files in the Playlist list box, click Remove All.

Selecting sound files in the playlist

You can select multiple sound files for previewing, adding, or removing by
holding down <Ctrl> or <Shift> while you choose them.

m Pressing <Ctrl> allows you to randomly select the sound files. 

m Pressing <Shift> allows you to select a group of adjacent tracks when you select the
first and last sound files in the group.

Rearranging sound files in the playlist

You can use your mouse to rearrange the sound files in the playlist.

To move a sound file in the playlist using a single-button mouse:

Hold down the x (Command) key as you drag the file in the Playlist list box to the new
position.

To move a sound file in the playlist using a multibutton mouse:

Use the right mouse button to drag the file in the Playlist list box to the new position.

The sound file moves to the position you choose.

IMPORTANT If you are in shuffle mode, Creative Wave will continue to play
the sound files randomly. To leave shuffle mode, click the shuffle mode button
to deselect it on the “touch sensitive” display. Once you have left shuffle
mode, Creative Wave will use your rearranged playlist.
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Naming the playlist

After compiling your playlist, you may give the playlist a title. To give your
playlist a title:

1 Click Save As.

The Save As dialog box similar to Figure 2-15 appears.

Figure 2-15 The Save As dialog box

2 Type the title of the playlist in the edit box.

3 Click OK.

Defining recording settings

To define the settings of a recording:

1 Click the record setting button.

The Record Settings dialog box (Figure 2-16) appears.

Figure 2-16 The Record Settings dialog box



2 Enter the format you want the recording to have.

m Mono or Stereo channel

m 11025 Hz, 22050 Hz, or 44100 Hz sampling rate

m 8-bit or 16-bit sampling size

3 Click OK.

Recording a sound file

Using Creative Mixer, you can record from audio sources such as your 
CD-ROM or MIDI. Although Creative Mixer also provides the option of
recording with line-in or a microphone, the PC Compatibility Card does not
support these two options. If you want to record from an audio CD or MIDI,
you can use the Sync options in the Creative Wave Control menu to
synchronize your recording with the playing of the audio. The audio is
recorded in wave format and saved as a sound file.

IMPORTANT The format of the recording is set using the Record Settings
dialog box.

To record a sound file in Creative Wave:

1 Choose CD Sync, MIDI Sync, or both from the Control menu. 

These options have been chosen when check marks appear next to them.

2 Click the record button.

The Wave Recording dialog box similar to Figure 2-17 appears.

Figure 2-17 The Wave Recording dialog box

61Creat ive Remote



3 Enter the name of the file you want to record to.

4 Click Start.

IMPORTANT When using the Sync options, the playing of the audio will
synchronize with the recording only if the audio player is activated. For
example, if you choose CD Sync from the Control menu, then either 
Creative CD or Creative Remote should be activated to run the audio CD.

Using the hot keys

You can use hot keys (key commands) to perform operations in Creative Wave:

Key command Description

<A> Pauses the sound file.

<B> Plays the previous sound file.

<Ctrl+D> Changes the information shown on the “touch sensitive” display.

<F> Plays the next sound file.

<F1> Activates onscreen help.

<G> Activates the graphic slider.

<H> Activates the shuffle mode selector.

<I> Activates the introduction mode selector.

<K> Rewinds the sound file.

<L> Opens the playlist.

<M> Activates the repeat mode selector.

<N> Minimizes Creative Wave to an icon.

<O> Quits Creative Wave.

<P> Plays the sound file.

<R> Records the sound file.

<S> Stops the sound file.

<Space bar> Confirms selection.

<W> Fast forwards the sound file.

<0> to <9> Selects sound files.
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Using Creative MIDI

You can use Creative MIDI to perform operations such as playing a MIDI file
and compiling a playlist.

Starting Creative MIDI

Creative MIDI has minor variations depending on the Windows version
installed on your computer. If you are using a version of Windows other than
Windows 95, refer to the onscreen help when Creative MIDI is different from
how it is described in this manual. In addition to starting Creative MIDI as
described here, you can also start it from Creative Remote with the invoke
player button. 

Starting Creative MIDI in Windows 95

1 Click the Windows 95 start button.

2 Point to Programs, then point to Sound Blaster 16 in the list of programs.

3 Click Creative MIDI in the Sound Blaster list of programs.

The Creative MIDI controls, similar to those in Figure 2-18, appear.

Figure 2-18 Creative MIDI

Starting Creative MIDI in Windows version 3.1 or higher

1 Double-click the Audio Software program group in the Program Manager window.

2 Double-click the Creative MIDI icon in the Audio Software program group window.

The Creative MIDI controls, similar to those in Figure 2-18, appear.

PlaylistFast track selector

Power off

Minimize

“Touch sensitive”
display

Playback
control

Menu
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Creative MIDI features

The Creative MIDI control panel consists of the following features:

m “touch sensitive” display

m power off button

m menu button

m minimize button

m playlist button

m playback control buttons

m fast track selector

The “touch sensitive” display in Creative MIDI

By clicking the “touch sensitive” display in Creative MIDI, you can switch
among displays of these categories of information:

m MIDI file playing status (showing whether a selected MIDI file is currently
playing)

m the number and elapsed time of the playing MIDI file

m titles of the MIDI file and playlist

A “touch sensitive” display for the number and elapsed time of the playing
MIDI file is shown in Figure 2-19.

Figure 2-19 The “touch sensitive” display for the number and elapsed time of the 
playing MIDI file

Track/sound file info

Player selector

Shuffle mode selector

Introduction mode selector

Graphic volume control

Graphic slider

Repeat mode selector
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The “touch sensitive” display contains the following components:

Item Description

Graphic slider Indicates the percentage of the current MIDI file that has played. It also
allows you to play the sound file from a different point in the file.

Graphic volume Shows the volume level of the player. 
control

Repeat mode selector Repeats the whole playlist when the final MIDI file has played.

Introduction mode Plays the first few seconds of all the MIDI files in the playlist.
selector

Shuffle mode selector Randomly arranges MIDI files in the playlist.

Power button

Click the power button to quit Creative MIDI.

Menu button

Click the menu button to display the Control menu (Figure 2-20):

Figure 2-20 The Creative MIDI Control menu

Opens
Creative Mixer

Quits Creative MIDI

Changes Creative MIDI to an icon

Displays onscreen help

Displays copyright and credits



Minimize button

The minimize button changes Creative MIDI to an icon located at the bottom
of your screen. To maximize Creative MIDI, returning it to its original size,
double-click the Creative MIDI icon.

Playlist button

The playlist button allows you to compile a selection of MIDI files that you
want to play. When you click the playlist button, a MIDI Playlist dialog box
similar to Figure 2-21 appears.

Figure 2-21 A MIDI Playlist dialog box
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The MIDI Playlist dialog box contains the following components:

Item Description

Collection Allows you to name your playlist.

List Files of Type Allows you to specify the type of files you want to view in the Files list box. 

Drives Displays the selected drive.

Directories Displays the directory search path.

Files Displays the files specified in the List Files of Type edit box.

Playlist Displays the files you have included in the playlist. 

Play Plays the selected MIDI files.

Add Adds the selected MIDI files to the Playlist list box. 

Add All Adds all the MIDI files to the Playlist list box.

Clear Clears the MIDI files in the Playlist list box.

Remove Removes selected MIDI files from the Playlist list box.

Done Confirms the compilation of MIDI files in the Playlist list box.

Cancel Cancels changes made in the Playlist list box. The playlist reverts to its
last saved copy.

Help Displays the onscreen help facility.

Save Saves the playlist using the name provided in the Collection edit box.

Save As Saves the playlist with a new name.
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Playback control buttons

The playback control buttons allow you to perform the playback operations. 

Button Description

Stops the MIDI file.

Plays the MIDI file.

Pauses the MIDI file.

Plays the previous MIDI file in the playlist.

Quickly rewinds the MIDI file in the playlist.

Fast forwards the MIDI file.

Plays the next MIDI file.

Fast track selector

The fast track selector allows you to select and play a MIDI file in the playlist
(see Figure 2-22).

Figure 2-22 The Creative MIDI fast track selector

Playing MIDI files

You can play MIDI files using the playback control buttons and fast track
selector.

To play a MIDI file using the fast track selector:

Click the button from the fast track selector that corresponds to the track you
want to play. If you want to play track 10, click 0. If you want to play track 12,
click 1 and then click 2.

IMPORTANT If you choose a MIDI file number that does not exist, the last
MIDI file in the playlist will be selected. 
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If you want to play a MIDI file from a certain point, you can use the graphic
slider to indicate where to start. You can do this before playing the file or
while it is playing.

To play the MIDI file starting at a different point:

1 Press and hold down the mouse button on the graphic slider and go to the point at which
you want to start the MIDI file, then release the mouse button.

If your player is already playing, the player will immediately go to the point
you have chosen and start playing.

2 If your player is not playing, click Play to start playing the MIDI file from the point you
have chosen.

Adjusting the volume

You can adjust the volume of Creative MIDI using the graphic volume
control. 

To adjust the volume:

1 Press and hold down the mouse button on the graphic volume control.

2 Adjust the volume to the level you want.

Working with the MIDI playlist

A playlist is a collection of tracks that are grouped in some order for playing.
You can compile tracks in the playlist using the MIDI Playlist list box.

Compiling the playlist

To compile the playlist:

1 Click the playlist button.

The MIDI Playlist dialog box similar to Figure 2-21 appears.
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2 Perform the desired operations:

m preview MIDI files

m add MIDI files

m remove MIDI files

m rearrange MIDI files 

m name the playlist 

3 Click Done when you are satisfied with the compilation of the playlist.

Adding MIDI files to the playlist

To add MIDI files to the playlist:

1 Select the MIDI files to add to the playlist from the Files list box.

2 Click Add to add the MIDI files to the Playlist list box. 

Note:  To add all the MIDI files in the Files list box to the Playlist list box,
click Add All.

Previewing MIDI files

To preview MIDI files:

1 Select the MIDI files from the Playlist or Files list box.

2 Click Play.

The MIDI file starts playing.

Note: You can also preview a MIDI file by double-clicking the MIDI file in a
list box.

Removing MIDI files from the playlist

To remove MIDI files from the playlist:

1 Select the MIDI files from the Playlist list box.

2 Click Remove.

Note:  To remove all MIDI files in the Playlist list box, click Remove All.



Selecting MIDI files in the playlist

You can select multiple MIDI files for previewing, adding, or removing by
holding down <Ctrl> or <Shift> while you choose them.

m Pressing <Ctrl> allows you to randomly select the MIDI files. 

m Pressing <Shift> allows you to select a group of adjacent tracks when you select the
first and last MIDI files in the group.

Rearranging MIDI files in the playlist

You can use your mouse to rearrange the MIDI files in the playlist.

To move a MIDI file in the playlist using a single-button mouse:

Hold down the x (Command) key as you drag the file in the Playlist list box to the new
position.

To move a MIDI file in the playlist using a multibutton mouse:

Use the right mouse button to drag the file in the Playlist list box to the new position.

The MIDI file moves to the position you choose.

IMPORTANT If you are in shuffle mode, Creative MIDI will continue to play
the files randomly. To leave shuffle mode, click the shuffle mode button on
the “touch sensitive” display to deselect it. Once you have left shuffle mode,
Creative MIDI will use your rearranged playlist.

Naming the playlist

Once you have compiled your playlist, you may want to give the playlist 
a title. To give your playlist a title:

1 Click Save As.

The Save As dialog box similar to Figure 2-23 appears.

Figure 2-23  The Save As dialog box
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2 Type the title of the playlist in the edit box.

3 Click OK.

Using the hot keys

You can use hot keys (key commands) to perform operations on Creative
MIDI:

Key command Description

<A> Pauses the MIDI file.

<B> Plays the previous MIDI file.

<Ctrl+D> Changes the information shown on the “touch sensitive” display. 

<F> Plays the next MIDI file.

<F1> Activates onscreen help.

<G> Activates the graphic slider.

<H> Activates the shuffle mode selector.

<I> Activates the introduction mode selector.

<K> Rewinds the MIDI file.

<L> Opens the playlist.

<M> Activates the repeat mode selector.

<N> Minimizes Creative MIDI to an icon.

<O> Quits Creative MIDI.

<P> Plays the MIDI file.

<S> Stops the MIDI file.

<Space bar> Confirms selection.

<W> Fast forwards the MIDI file.

<0> to <9> Selects MIDI files.
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Creative Soundo’LE plays and records sound file data. Buttons in the
Soundo’LE window allow you to play, stop, pause, and record. When you play
a sound file, the LED Display shows the amplitude of the sound. 

Soundo’LE supports Object Linking and Embedding (OLE). With this
capability, you can insert sound into other applications by linking sound files
to a document or embedding sound files in a document. For more
information about OLE, refer to the Microsoft Windows manual.

IMPORTANT You must have Windows 95 or Windows version 3.1 or higher
installed on your system in order to use Creative Soundo’LE.

This chapter is organized as follows:

m Starting Soundo’LE

m The Soundo’LE menus

m Opening a sound file

m Playing a sound file

m Recording a sound file

m Selecting recording characteristics

m Embedding a sound file

m Linking a sound file

m Quitting Soundo’LE

3 Creative Soundo’LE



Starting Creative Soundo’LE

Creative Soundo’LE has minor variations depending on the Windows version
installed on your computer. If you are using a version of Windows other than
Windows 95, refer to the onscreen help when Creative Soundo’LE is different
from how it is described in this manual.

Starting Creative Soundo’LE in Windows 95

1 Click the Windows 95 start button.

2 Point to Programs, then point to Sound Blaster 16 in the list of programs.

3 Click Soundo’LE in the Sound Blaster 16 list of programs.

A Soundo’LE window similar to Figure 3-1 appears.

Figure 3-1 The Soundo’LE window

Starting Creative Soundo’LE in Windows version 3.1 or higher

1 Double-click the Audio Software program group in the Program Manager window.

2 Double-click the Soundo’LE icon in the Audio Software program group window.

A Soundo’LE window similar to Figure 3-1 appears.
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The Soundo’LE menus

Soundo’LE has four menus: File, Edit, Options, and Help. 

The File menu

Here’s what the commands on the File menu do:

Command Description

New Creates a new sound file without any data.

Open Loads an existing sound file.

Save Saves the sound file.

Save As Saves the sound file with a new name.

Properties Displays the settings and attributes for the current sound file.

Exit Quits Soundo’LE.

IMPORTANT Soundo’LE keeps a record of the last four sound files you have
opened. They are displayed at the end of the File menu. To open one of these
files, click its name.

The Edit menu

Here’s what the commands on the Edit menu do:

Command Description

Copy Sound as an Copies the sound data and OLE information to the Clipboard. The sound 
Object data can then be pasted into a document as an embedded or linked

object.

Run Wave Editor Activates Creative WaveStudio. For more information on Creative
WaveStudio, refer to Chapter 1, “Creative WaveStudio.”
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The Options menu

Here’s what the commands on the Options menu do:

Command Description

Preferences Displays the OLE options available in Soundo’LE.

Toolbar Displays the toolbar when checked. Hides the toolbar when unchecked.

Status Bar Displays the Status Bar when checked. Hides the Status Bar when
unchecked.

Mixer Settings Activates Creative Mixer. For more information, refer to Chapter 4,
“Creative Mixer.”

Recording Settings Allows the sampling size, frequency, and mono or stereo mode to be
selected for recording.

Select Wave Device Allows the selection of a wave device to be used for recording.

Always on Top Makes Soundo’LE the topmost window.

The Help menu

Here’s what the commands on the Help menu do:

Command Description

Help for Soundo’LE Opens the Windows help files for Soundo’LE.

Using Help Gives tips on using Windows help files.

About Soundo’LE Opens a window displaying copyright information.

You can use the keyboard to perform operations in Soundo’LE. For
instance, you can use either <Tab> or the Left and Right Arrow keys to
move to the various buttons on the Soundo’LE window. To choose a button,
press <Space bar>.

You can also move around the open sound file with the aid of the slider.
Simply select the slider thumb, and drag with the mouse. Alternatively, you
can use the Left and Right Arrow keys.
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Opening a sound file

To open a sound file:

1 Choose Open from the File menu.

The “Open a Sound File” dialog box similar to Figure 3-2 appears.

Figure 3-2 The “Open a Sound File” dialog box

2 Type or select the name of the sound file you want to open. 

You can preview the file before opening it by choosing Play. You can also
view information such as the wave format, data size, and the file date
displayed in the dialog box.

3 Click Open.
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Playing a sound file

To play a sound file:

1 Open the sound file.

2 Click the Play button.

To stop playing the sound file, click Stop.

Recording a sound file

To record a sound file:

1 Choose New from the File menu.

Soundo’LE opens a new, untitled sound file.

2 Click the Record button. 

To stop the recording, click Stop.

Selecting recording settings

You can use one of three predefined sound quality recording settings or you
can choose to create your own settings. The three predefined sound quality
settings available are CD Quality, Radio Quality, and Telephone Quality. 

To select your own sound quality recording settings:

1 Choose Record Settings from the Options menu.

The Record Settings dialog box similar to Figure 3-4 appears.

Figure 3-4 The Record Settings dialog box
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2 Click the arrow next to the Format box to view the format options.

3 Click to select the format you want.

The format you choose will determine the choices available in the 
Attributes box.

4 Click the arrow next to the Attributes box to view your options.

5 Click to select the attributes you want.

6 Decide if you want to select the CD Sync checkbox to synchronize the start of the
recording with the playback of your audio CD.

7 If you want to save your settings to use with other sound files, click Save As and give the
new settings file a name. Click OK.

. 8 Click OK to return to the Soundo’LE window.

9 Click the arrow next to the Sound Quality Scheme box to view the available settings.

10 Click to select the settings you want. You can use the settings you created, or choose
one of the three predefined settings.

Embedding a sound file

When you embed a sound file, you load a copy of the sound file in
Soundo’LE and transfer it to an application program such as WordPad that
supports Object Linking and Embedding (OLE). If you edit the sound file in
Soundo’LE, the sound file in WordPad will not be affected because you no
longer have any connection to the file.

You can embed a sound file using one of the following three methods:

m from a document (one created in WordPad, for example)

m from Soundo’LE

m by dragging the icon located in the Soundo’LE window and inserting it
into an open document
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Embedding a sound file starting from a document

You can embed a sound starting from most word-processing documents using
the method described for WordPad.

To embed a sound file starting from WordPad:

1 Open the WordPad document in which you want to embed a sound file.

2 Choose Object from the Insert menu.

An Insert Object dialog box similar to Figure 3-5 appears.

Figure 3-5 The Insert Object dialog box

3 Select Creative Soundo’LE.

4 If you want to create a new Soundo’LE file to embed in the document, select Create New.
If you want to embed an existing Soundo’LE file, select “Create from File”.

5 Click OK.

6 Choose Update Document from the Soundo’LE File menu.

This embeds the sound file in the WordPad document. An icon representing
the sound file is placed in the document.

7 Choose “Exit & Return to Document” from the Soundo’LE File menu. 

This returns you to the WordPad document.
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Embedding a sound file starting from a Soundo’LE

To embed a sound file starting from Soundo’LE:

1 Open Soundo’LE.

2 Record a new sound file or open an existing sound file you want to embed.

3 Choose “Copy Sound as an Object” from the Edit menu.

The sound file is placed onto the Clipboard.

4 Open the WordPad document in which you want to embed the sound file.

5 Select Paste Special from the Edit menu in WordPad.

The Paste Special dialog box appears.

6 Select Creative Soundo’LE from the Paste As list.

7 Click OK.

The icon representing the embedded sound file appears in the document.

Embedding a sound file using the drag-and-drop method

To embed a sound file using the drag-and-drop method:

1 Position the Soundo’LE window and application window so that both are in view.

2 In Soundo’LE, open the sound file that you want to drag to the document. Alternatively,
you can do a recording and save it as a new file before you include the file in the
document.

Soundo’LE will display the icon in its window when a sound file is opened.
No icon is displayed in the Soundo’LE window if no sound file is selected.

3 Open your program document.

4 Position your pointer on the icon in the Soundo’LE window and drag the icon to the
document.
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5 Release the mouse button.

The icon representing the Soundo’LE file appears in the document 
(see Figure 3-6).

Figure 3-6 Embedding a sound file using the drag-and-drop method

Linking a sound file

When you link a sound file to an application such as WordPad, you are not
making a copy of the sound file and then pasting it into the document.
Instead, you are only making a reference to the sound file. If you edit the
sound file in Soundo’LE, the reference in the document is updated to reflect
the changes.

To link a sound file in WordPad:

1 Open Soundo’LE.

2 Create a new sound file or open an existing file that you want to link.

3 Save the sound file.

The sound file must be saved before you can link it to an OLE client.

4 Choose “Copy Sound as an Object” from the Soundo’LE Edit menu.

The sound file is copied onto the Clipboard.
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5 Open the WordPad document you want to link the sound file to.

6 Choose Paste Special from the WordPad Edit menu.

The Paste Special dialog box appears.

7 Select Paste Link in the Paste Special dialog box.

8 Click OK.

The icon representing the Soundo’LE file appears in the document.

Quitting Soundo’LE

To quit Soundo’LE:

1 Choose Exit from the File menu.

The Soundo’LE dialog box similar to Figure 3-7 appears if the latest changes
have not been saved.

Figure 3-7 The Soundo’LE dialog box

2 Click Yes to save the changes, No if you do not want to save the changes, or Cancel if
you want to continue working in Soundo’LE.
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Creative Mixer is a powerful audio mixer that allows you to combine and edit
sound from various audio sources. You can use Creative Mixer in conjunction
with Creative Wave to record input from an audio CD or MIDI source.
Although Creative Mixer also offers the option of recording with line-in or a
microphone, the PC Compatibility Card does not support these options.

IMPORTANT To use Creative Mixer, you must have Windows 95 or Windows
version 3.1 or higher installed on your system.

This chapter is organized as follows:

m Starting Creative Mixer

m Moving around in Creative Mixer

m Creative Mixer features

m Creative Mixer control menu

m Creative Mixer LED display

m Customizing Creative Mixer 

m Quitting Creative Mixer

4 Creative Mixer



Starting Creative Mixer

Creative Mixer has minor variations depending on the Windows version
installed on your computer. If you are using a version of Windows other than
Windows 95, refer to the onscreen help when Creative Mixer is different from
how it is described in this manual.

Starting Creative Mixer in Windows 95

1 Click the Windows 95 start button.

2 Point to Programs, then point to Sound Blaster 16 in the list of programs.

3 Click Creative Mixer in the Sound Blaster 16 list of programs.

The Creative Mixer window similar to Figure 4-1 appears.

Creative Mixer Window and Buttons

Power off

Minimize

Recording volume control

Show/hide LED display

Minimum view

Custom view

Expanded view

Figure 4-1 The Creative Mixer window
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Starting Creative Mixer in Windows version 3.1 or higher

1 Double-click the Audio Software program group in the Program Manager window.

2 Double-click the Creative Mixer icon in the Audio Software program group window.

The Creative Mixer window similar to Figure 4-1 appears.

Moving around in Creative Mixer
You can move around easily in Creative Mixer using either the mouse or 
the keyboard.

m To select a select box, click it. 

m To adjust the slider bar, drag it to the desired position.

m To advance from one option to another, press <Tab>.

m To move to the previous option, press <Shift+Tab>.

m To select an option in a select box, press <Space bar>.

m To adjust the volume of audio sources, use the Up or Down Arrow key.

Creative Mixer features

Creative Mixer consists of the following features:

m power off button

m minimize button

m recording/volume controls button

m show/hide LED display button

m minimum view button

m custom view button

m expanded view button

m audio source select boxes and sliders
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Power off button

Click the power off button to quit Creative Mixer.

Minimize button

The minimize button changes Creative Mixer to an icon located at the bottom
of your screen. To maximize Creative Mixer, returning it to its original size,
double-click the Creative Mixer icon.

Recording/volume controls button

Use the recording/volume controls button in conjunction with the audio
source select boxes and sliders to control the recording input and volume
levels for the audio sources you want to record.

When the button displays a green triangle the audio source select boxes 
display red microphones . The microphones indicate that the recording
level controls are in effect. Any adjustments made with the vertical or
horizontal sliders affect the audio source recording level input and balance.

When the button displays a red dot the audio source select boxes 
display green speakers . The speakers indicate that the volume controls
are in effect. Any adjustments made with the vertical or horizontal sliders
affect the audio source volume level and balance.

Show/hide LED display button

The show/hide LED display button reveals or conceals the Creative Mixer
LED display.

Minimum view button

The minimum view button shows only one audio source and the Creative
Mixer LED display.
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Custom view button

The custom view button shows only the audio sources and controls you
choose to reveal. For information on choosing the audio sources and controls
you wish to reveal in custom view, refer to the “Customizing Creative Mixer”
section later in this chapter.

Expanded view button

The expanded view button shows all the possible audio sources available 
for recording.

Note:  Although Creative Mixer displays line and microphone input as
possible audio sources, these two sources are not available because they are
not supported by the PC Compatibility Card.

Audio source select boxes and sliders

The audio source select boxes and sliders control the recording input and
volume levels for the audio sources you want to record. 

Select boxes

The audio source select boxes display either red microphones or green 
speakers . A red microphone indicates that the recording level controls
are in effect. A green speaker indicates that the volume controls are in effect.
To select an audio source for recording, click the select box beneath the audio 
source until a sound wave appears in the box next to the microphone or
speaker. To deselect an audio source, click the select box below the audio
source until the sound wave disappears.

Vertical sliders

When the audio source select box displays a red microphone, the vertical
slider beneath the select box controls the recording input level of the selected
audio source.

When the audio source select box displays a green speaker, the vertical slider
beneath the select box controls the volume level of the selected audio source.
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Horizontal sliders

When the audio source select box displays a red microphone, the horizontal
slider beneath the select box controls the recording input balance of the
selected audio source.

When the audio source select box displays a green speaker, the horizontal
slider beneath the select box controls the volume balance of the selected
audio source.

Note:  To reset the horizontal slider to equal distribution, double-click the
slider thumb.

You can activate any slider by using the following hot keys (key commands):

Key command Description

<C> CD volume

<D> MIDI volume

<M> Master volume

<P> PC Speaker volume

<V> Wave volume
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Creative Mixer control menu

The Control menu contains many options you can use to control Creative
Mixer (see Figure 4-2). To open the Control menu, hold down the x key and
click anywhere within the Creative Mixer window.

Figure 4-2 The Control menu
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Creative Mixer LED display

The Creative Mixer LED display allows you to graphically view audio
source data.

To open the Creative Mixer LED display:

Choose View from the Control menu and click LED Display.

The Creative Mixer LED display appears.

When you click the LED display, you can alternate between any of the
following displays:

m Power Spectrum shows different frequency levels of the output (see 
Figure 4-3).

Figure 4-3 The Power Spectrum

m VU Meter shows the intensity of the sound entering both the left and right
speakers (see Figure 4-4).

Figure 4-4 The VU Meter
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m Scope shows the combined amplitude of waves from the selected audio
sources (see Figure 4-5).

Figure 4-5 The Scope

IMPORTANT The Creative Mixer LED display will not be seen during the
playback or recording of sound files. 

IMPORTANT For stereo recording, make sure the left signal (L) of the audio
source is directed to the Left In channel and the right signal (R) to the Right
In channel.

For mono recording from stereo source, select the source’s left and/or right
channels in the Left In box.

Customizing Creative Mixer

You can change the appearance of Creative Mixer by choosing one of three
views:  minimum view, custom view, or expanded view. Custom view displays
only the audio sources and controls you choose.
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To choose the audio sources and controls you want to display in custom view:

1 Choose Preferences from the Control menu.

The Preferences dialog box similar to Figure 4-6 appears

Figure 4-6 The Preferences dialog box

Note: The PC Compatibility Card does not support the Line-In and 
Microphone options.

2 Click the checkbox next to the audio sources and controls you want as a part of your
custom view. When an audio source or control is selected a check appears in the box.

3 Click OK to save your custom view settings.

Here’s what some of the options in the Preferences dialog box do:

m Balance Control displays or hides the horizontal balance sliders.

m Balloon Help activates or deactivates balloon help in Creative Mixer.

m Save Settings On Exit saves all the changes made to Creative Mixer settings.

Quitting Creative Mixer

To quit Creative Mixer:

Choose Close from the Control menu or click the power off button.
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95

The MIXERSET Utility is a DOS program that allows you to control the
volume level and balance of the audio sources you want to play or record.

You can use the MIXERSET Utility by typing commands at the DOS prompt
or Windows command line, or by using the MIXERSET control panel.

IMPORTANT To use the MIXERSET Utility, you must have DOS but not
Windows 95 installed on your computer. You can use the MIXERSET utility
with Windows version 3.1 or Windows for Workgroups.

This chapter provides you with detailed information on using MIXERSET. It
is organized as follows:

m Using MIXERSET commands

m Using the MIXERSET control panel

m MIXERSET control panel features

m Using the mouse and keyboard
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Using MIXERSET commands

To control sound mixing options using commands, you type first the
MIXERSET command, then the control that specifies what you want to have
happen. You can type commands at the DOS prompt or at the Windows
Command line.

Controls can be categorized into the following:

m execution controls

m volume controls

m miscellaneous controls

These controls are listed and explained in the sections following the
instructions for using MIXERSET commands.

IMPORTANT When specifying the controls, you do not need to type the full
name since the shortened names work equally well. However, you need to
type at least the first two characters, except the execution controls which have
only one character.

Using commands at the DOS prompt

To use MIXERSET commands at the DOS prompt:

1 Change the directory to be your sound directory.

2 At the sound directory, type MIXERSET [controls] ... at the DOS prompt
and press <Return>.

Using commands at the Windows command line

To use MIXERSET commands at the Windows command line:

1 Go the the Windows command line by choosing Run from the Program Manager 
File menu.

The Run dialog box appears.

2 Change the directory to be your sound directory. If you do not know the location of the
sound directory, use the Browse button. 

3 Once you have switched to the sound directory, type MIXERSET [controls]

... at the command line and press <Return>.
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Execution controls

The execution controls are as follows:

/? or /H opens MIXERSET help files

/Q runs MIXERSET without displaying the setting information

/P opens and runs MIXERSET according to the user-defined
preset levels for audio input and output. The preset levels can
be updated with new settings by making any new adjustments
and then saving the changes. The process of saving creates the
new preset and stores it in the CTMIX.CFG file.

Volume controls

To set the MIXERSET volume by typing commands at the DOS prompt or
Windows command line, use the following controls:

/MA:n;x sets the MASTER volume and balance of left and right speakers

/VO:n;x sets the VOICE volume and balance of left and right speakers

/MI:n;x sets the MIDI volume and balance of left and right speakers

/CD:n;x sets the CD volume and balance of left and right speakers

/SP:n sets the PC SPEAKER volume

In volume controls, n specifies the volume level. It ranges from 0 to 255
where 0 turns off the volume completely and 255 is the maximum 
volume setting.

In volume controls, x specifies the balance of left and right speakers. It ranges
from –5 to +5 where –5 channels the sound output totally to the left speaker
and +5 channels the sound output totally to the right speaker. To channel the
sound output equally to both speakers, x must be 0. In addition, x must be
preceded by “;”.
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The following are some examples of how you can set the volume controls at
the DOS prompt or Windows command line:

To set the PC speaker volume to 200:

m Type MIXERSET /SP:200 and press <Return>.

To set the master volume to 200 with balanced output through the left and right speakers:

m Type MIXERSET /MA:200 and press <Return>. If balance is not
specified, both speakers will be set equally.

To specify both of the above settings in one command:

m Type MIXERSET /SP:200 /MA:200;0 and press <Return>.

To set the master volume at 200 but with reduced volume in the left speaker:

m Type MIXERSET /MA:200;+5 and press <Return>.

To reduce the volume in the right speaker only:

m Type MIXERSET /MA:;-5 and press <Return>.

Miscellaneous controls

To set the miscellaneous features in MIXERSET by typing commands and
pressing <Return> at the DOS prompt or Windows command line, use the
following controls:

/OPS:ss Turns on or off the audio source for the speakers.

OPS stands for output source.

Replace the ss with the abbreviation for the sound source you want
to use.
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For example, for the command /OPS:CD+, the CD indicates that the sound
source specified is an audio CD. The “+” turns the CD sound source on so
that the CD audio is passed to the speakers. A “–” following the sound source
turns the sound source off.

/IPL:ss Specifies the input to the left channel during recording. The input
can be either the left or right channel, or both channels of each
recording source. IPL stands for input left.

/IPR:ss Specifies the input to the right channel during recording. The
input can be either the left or right channel, or both channels of
each recording source. IPR stands for input right.

For /IPL:ss and /IPR:ss, ss indicates whether a device’s left and/or right
channels are turned on or off for recording. “CDL” and “CDR” respectively
specify the CD’s left and right channels as recording sources. A “+” or “–”
follows to turn each recording source on or off. You can specify one or 
more recording sources simultaneously. For example, MIXERSET
/IPL:CDL+ /IPR:CDR+ selects the CD’s left channel and right channel 
for recording into the left and right channels respectively.

Using the MIXERSET control panel

How you open the MIXERSET control panel depends on whether you are in
DOS or in Windows. Once you are in MIXERSET, you use your mouse and
keyboard to specify what you want. See “Using the Mouse and Keyboard”
later in this chapter.

Opening the MIXERSET control panel from the DOS prompt

To open the MIXERSET control panel from the DOS prompt:

1 Change the directory to be your sound directory.

2 Type MIXERSET at the DOS prompt and press <Return>.

The MIXERSET control panel shown in Figure 5-1 appears.
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Opening the MIXERSET control panel 
from the Windows command line

To open the MIXERSET control panel from the Windows command line:

1 Go to the Windows command line by choosing Run from the Program Manager 
File menu.

The Run dialog box appears.

2 Change the directory to be your sound directory. If you do not know the location of the
sound directory, use the Browse button. 

3 Once you have switched to your sound directory, type MIXERSET and click OK.

The MIXERSET control panel shown in Figure 5-1 appears.

IMPORTANT The PC Compatibility Card does not support the Line and 
Mic features shown on the MIXERSET control panel.

Figure 5-1 The MIXERSET control panel
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MIXERSET control panel features

The MIXERSET control panel has the following features:

m volume sliders

m balance sliders

m save button

m input box

m output box

Volume sliders

The larger sliders control the volume levels of the input sources.

Balance sliders

The smaller slider under each volume slider controls the balance of the left
and right speakers for audio sources with stereo capability. Moving the slider
to the left decreases the volume of the right speaker but the left speaker
volume remains constant. Moving the slider to the right decreases the volume
of the left speaker but the right speaker volume remains constant.

Save button

The Save button saves all changes made to the settings in MIXERSET. They
become the new preset settings stored in the CTMIX.CFG file. The new
settings are used the next time you open MIXERSET using the command
MIXERSET/P (for preset settings).

Input box

The input box enables you to select the audio sources you want to record from.
The audio sources available are MIDI and CD. You can direct these audio
sources through the left or right channels or through both channels.

IMPORTANT To achieve a stereo sound effect, make sure that the left channel
signal of the audio source is directed to the Left-In channel and the right
signal to the Right-In channel.
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Output box

The Output box enables you to control the left and right channel output for
your selected audio source.

Using the mouse and keyboard

To work with the controls in the MIXERSET control panel, you need to use
your mouse in Windows version 3.1 or higher or your keyboard in DOS:

m Click to select or deselect a checkbox.

m Drag a slider to move it, or click at the extreme end of the slide to increase
or decrease the volume.

m Press <Tab> to advance to the next feature.

m Press <Shift+Tab> to return to the previous feature.

m Press the Up or Down Arrow keys to move from one option to another
within each feature.

m Press the Left or Right Arrow keys to adjust the volume and balance levels.

m Press <Space bar> or <Return> to select or deselect a checkbox.

m Press <Esc> to quit the MIXERSET control panel.
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Welcome to the 16-bit audio software that delivers the next wave of audio
capability to your PC Compatibility Card. With it, you can use your computer
to sample high quality digital audio.

In the Windows environment, Sound Blaster 16 offers the following programs
for working with PC sound:

m Creative WaveStudio

m Creative Remote

m Creative Wave

m Creative CD

m Creative MIDI

m Creative Soundo’LE

m Creative Mixer

In DOS (if Windows 95 is not installed on your computer), you can use the
Sound Blaster 16 MIXERSET utility to set volume and recording levels for
audio sources.
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System requirements

To use the Sound Blaster 16 Windows programs, you must have Windows 95
or Windows version 3.1 or higher installed on your system.

To use the MIXERSET Utility, you must have DOS but not Windows 95
installed on your computer. You can use the MIXERSET Utility with
Windows version 3.1 or Windows for Workgroups.

Document conventions

This manual uses the following conventions to help you locate and identify
information.

Convention Used for

<   > Characters in pointed brackets represent symbols, letters, and key names 
on the keyboard.

[   ] Words in straight brackets explain the type of information you need to type.

<Key1+Key2> The plus sign (+) between Key1 and Key2 means that both keys have to 
be pressed simultaneously. For example, “Press <Control+Z>” means that 
the <Control> and <Z> keys have to be pressed at the same time.

<Key1,Key2> The comma (,) between Key1 and Key2 means that the keys have to be
pressed in sequence. For example, “Press <C,Return>” means that you
press the <C> key and release it, and then press the <Return> key and
release it.

Italic Represents a type of information you must supply. Italicized words are
often used in conjunction with straight brackets to describe information
needed as part of DOS commands.

IMPORTANT Areas of text where the information or instructions should be read 
especially carefully.

The mouse icon precedes instructions for operations that require the use 
of the mouse.

The keyboard icon precedes instructions for operations that require the 
use of the keyboard.
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This manual assumes you are using a standard, single-button mouse. If you
have a multibutton mouse, use the left mouse button for actions requiring the
use of the standard mouse button. Use the right mouse button for actions
requiring the use of the standard mouse button while holding down the x
(Command) key. 

The pointer, the symbol that you see on the computer screen when you move
your mouse, is sometimes called a cursor in Sound Blaster 16 programs.

Starting Sound Blaster 16 programs

You start any Sound Blaster 16 program the same way, although that way
depends upon whether you are using Windows 95 or Windows version 3.1 
or higher.

Starting Sound Blaster 16 in Windows 95

1 Click the Windows 95 start button.

2 Point to Programs, then point to Sound Blaster 16 in the list of programs.

The menu structure similar to Figure P-1 appears.

Figure P-1 The path to a Sound Blaster 16 program

3 Click the Sound Blaster 16 program you want to use.
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Starting Sound Blaster 16 in Windows version 3.1 or higher

1 Double-click the Audio Software program group in the Program Manager window.

2 Double-click the icon for the Audio Software program you wish to use.
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